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NOTICE

Due to frequent upgrades, PCLink is not distributed with 
new Link ECU's.

PCLink is available for free download at the following 
web site:

www.  LinkECU.com  

Should internet download not be practical, a copy of the 
latest version of PCLink on CD can be requested from 

your nearest Link Dealer.
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INTRODUCTION

Thank you for purchasing your Link ElectroSystems Ltd. Plug-In 
Engine Control Unit (ECU).  Link G4 ECU's are an advanced, 
fully programmable microprocessor controlled Engine 
Management System.  

The G4 software platform boasts an impressive list of features 
giving a new level of user adjustment.  This flexibility allows the 
tuner to have complete control over the engine management 
system.  G4 software employs high resolution fuel and ignition 
tables with configurable load and RPM centers.  When coupled 
with up to six dimensional fuel and ignition mapping, barometric 
pressure compensation and intake air temperature correction this 
gives an unprecedented level of tuning accuracy.  All G4 ECU's 
are in field upgradeable, there is no need to return the unit for 
software updates.

All Link G4 Plug-In Engine Management Systems are designed 
with flexibility and ease of installation in mind.  Link Plug-In 
systems are deigned to replace the circuit board inside the 
factory ECU enclosure.  This provides an invisible install that 
requires no modification to vehicle wiring and ECU mounting.

Link Engine Management Systems are designed with the final 
result in mind.  Not only do they boast an impressive range of 
performance features, but are designed with a focus on safety, 
reliability and drive-ability.  However, the ultimate success of your 
engine management upgrade is determined by how well the 
system is installed and tuned.

Installing and tuning any aftermarket engine management system 
is not to be taken lightly.  G4 ECU's give the tuner the control & 
flexibility that only top after-market engine management systems 
in the world can provide.  While every effort has been made to 
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keep G4 ECU's as user friendly as possible, it should be 
recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two 
important tasks.

1. This manual covers the installation of your G4 ECU.  While 
it is not strictly essential that this work is performed by an 
automotive electrician, the knowledge and tools available 
to these professionals makes it highly recommended. 
Regardless of who does  the installation, it is of utmost 
importance that instructions provided in this manual are 
followed exactly throughout the installation.  

      

2. Once the G4 ECU has been installed it will need to be 
tuned using a laptop computer with PCLink software. 
Information on the configuration and tuning of the G4 ECU 
is detailed in the online help section of PCLink.  G4 ECU's 
are shipped pre-loaded with a base  configuration that 
should be close enough to get most engines running after 
a few application specific adjustments have been made. 
While hearing the engine running on the new ECU for the 
first time is always a satisfying feeling, it is important to 
realise that the job is not complete.  The amount of tuning 
performed and the experience of the tuner are the two 
most important factors in determining how happy you will 
be with your engine management system.

Should any issues arise during installation, the following options 
exist for technical support:

1. Contact your nearest Link dealer.  A Link dealer list is 
available on our website.

2. Link website:  www.  LinkECU.com  
3. Technical Support Email:  tech@  LinkECU.com  
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4. Online Discussion Board: Available from the Link website.

The majority of questions received by the technical support team 
are  clearly answered in the manuals.  To speed up your 
technical inquiry please consult the manuals to make sure that 
your question has not already been answered.

SAFETY FIRST

Your Link Plug-In ECU is designed to enhance the performance 
of your vehicle.  However in all cases, your vehicle must be 
operated in a safe manner.  Do not tune your vehicle while 
operating it on public roads.  Obey road rules at all times.

Failure to follow all installation 
and operating instructions may 
result in damage to the Link 
ECU, personal injury, or harm 
to property.

DISCLAIMER

All care has been taken to ensure the pin outs and 
interconnections of the ECU to the vehicles wiring harness are 
correct.  However due to variations between vehicle models it is 
the installers responsibility to check wiring connections BEFORE 
installing the ECU.  Link ElectroSystems Ltd. will not be held 
responsible for any damage caused by the incorrect installation 
of this product.
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PRE-INSTALLATION

Before installing the ECU into the vehicle some pre-installation 
checks must be performed.

INTERCOOLER SPRAY OPTIONS

The locationg of the intercooler spray relay pin changed 
between models.  Set the provided jumper in the 
correct location for your model.

INJECTOR IMPEDANCE

The EVO IV-VIII G4 Plug-In ECU is NOT designed to 
be used directly with low impedance injectors.

All models this ECU is designed for are fitted with low impedance 
injectors from factory.  Current through low impedance injectors 
is reduced by the use of factory fitted injector ballast resisters. 
This means that the ECU is plug-in compatible with factory fitted 
injector combinations on all models.  DO NOT remove the factory 
fitted ballast resisters.
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INSTALLATION

The following sections describe physical installation of the ECU 
and required sensors.  It is recommended that your Link ECU is 
installed and tuned by a professional.  This will ensure you get 
the most out of your Link ECU and minimise the possibility of 
damage to the ECU or vehicle.  G4 ECU's are sophisticated high 
end system and require significant knowledge of engine 
management to tune.

ECU HANDLING PROCEDURES

WARNING
The  following  installation  process  will  require 
handling of both the  Link ECU and factory ECU. 
Both of these are highly sensitive to electrostatic 
discharge  and  are  easily  damaged.   Follow  the 
anti-static  precautions  given  in  this  manual 
carefully  to  avoid  damaging  electronic 
components.   Warranty  claims  for  ECU's 
damaged by electrostatic discharge will  NOT be 
accepted.
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ANTI-STATIC HANDLING GUIDELINES
Your body builds up an electrical charge as you move around. 
This charge can reach very high voltages.  Whenever given the 
opportunity this energy will attempt to discharge (usually 
through your finger tips!).  This can be fatal to most electronic 
components.  Most people have experienced an electrostatic 
discharge when they step out of their car or touch a metal 
bench top.  

The following guidelines describe precautions that can be 
taken to reduce the possibility of damaging your ECU:

1. Work only on a conductive surface.  A clean steel bench 
is suitable.

2. Always wear a wrist strap that is electrically connected 
to the conductive working surface.

3. Touch the working surface regularly.

4. Do NOT touch components on the circuit board.

5. Where possible, only handle the ECU by its plastic 
header.

6. Do NOT carry the ECU around without static packaging. 

7. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of 
damaging the ECU.  Note that failure due to static damage 
often does not appear until well after it was caused.
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FITTING THE ECU

The following steps outline the installation procedure:

1. Remove the factory ECU from the vehicle:  Ensure 
the key is in the OFF position.  The factory ECU 
is located on the left A pillar about 30cm above the 
floor.  Unplug the wiring harness from the factory 
ECU.  Remove the 6mm bolts (10mm socket) that 
retain the ECU and remove the ECU from the 
vehicle. DO NOT touch the exposed pins in the 
factory ECU connector.

2. Remove the factory ECU's circuit board from its 
enclosure:  Ensure you are following the given anti-
static guidelines and ARE WEARING A 
CONDUCTIVE WRIST STRAP connected to a 
conductive working surface.  Using four small flat 
bladed screwdrivers, carefuly pry apart the four 
plastic lugs retaining the ECU's header plate into 
the case.  Some force may be required to remove 
the circuit board from te case as it may be partially 
glued to the inside.  Remove the circuit board by 
removing the retaining screws.  Hold it only by the 
plastic header and place it aside.

3. Connect the ECU USB tuning cable and the 
expansion loom if required.

4. Fit the Link Plug-In ECU:  If fitting to a short case, 
CAREFULY snap the PCB extension off.  It may be 
necessary to use a sharp nife to first score the 
break off points.  Place the factory ECU in the 
packaging your Link ECU came in for its protection.

5. Carefuly fit the supplied aluminium end plate to the 
enclosure.  Make sure the end plate is fitted to allow 
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any cabels to exit on the left side of the header. 
Reassemble the enclosure and fit the ECU back to 
the vehicle.

6. Connect the ECU to the factory wiring loom. 

7. Do NOT attempt to start the vehicle.  Proceed to 
read through the remaining sections of this manual 
first.
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FITTING ADDITIONAL SENSORS

G4 Plug-In ECU's offer various options for the installation of 
additional sensors and devices.  As a minimum it is 
recommended that all ECU's are installed with a Manifold 
Absolute Pressure (MAP) sensor and Intake Air Temperature 
(IAT) sensor.  These parts can be purchased if required from 
your nearest Link dealer.  Additional details on wiring of various 
sensors can be found in any

MAP SENSOR

It is important that the pressure source for a MAP sensor be 
taken from a stable pressure source after the throttle body.  It is 
common to 'T' into the fuel pressure regulators pressure signal. 
Do NOT share this signal with other devices such as boost 
gauges or blow off valves.

The Link G4 EVO IV-VIII Plug-In ECU supports several options 
for fitting of a MAP sensor.   Any one of the following options can 
be used:

1. Factory MAP Sensor – From factory, some models 
supported by this ECU (some EVO VII and VIII) are fitted 
with a factory MAP sensor.  The factory MAP sensor is 
wired to An Volt 1.

2. MAP Thorugh AFM – The factory AFM wiring can be 
used to install a MAP sensor.

EVO V AFM Pinout (looking into wire side of connector).
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3. MAP Through Expansion Connector - The expansion 
connector provides power ground and analog channels for 
the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as 
MAP sensor in PCLink and a MAP calibration has been 
performed before attempting to start the vehicle.

IAT SENSOR

It is highly recommended that an IAT sensor be fitted in all 
applications to provide an input for correction of fuel and ignition 
based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location 
that accurately represents intake temperature.  The most 
common location is just prior to the throttle body.  Installing in the 
manifold is not recommended due to heat soak issues.  A fast 
response sensor must be used in all forced induction 
applications.

From factory, models supported by the Link G4 EVO IV-VIII Plug-
In ECU are not fitted with a suitable IAT sensor.  The Link G4 
EVO IV-VIII Plug-In ECU supports several options for fitting of an 
IAT sensor.   Any one of the following options can be used:

1. IAT Thorugh AFM – The factory AFM wiring can be used 
to install a MAP sensor.  An Temp 2 is wired to the AFM's 
temperature sensor.  Refer to the MAP sensor wiring 
information above.

2. IAT Through Expansion Connector - The expansion 
connector provides ground and temperature channels for 
the connection of an IAT sensor.  Wire the sensor between 
the Ground pin and an An Temp channel pin.  Note that 
not all ECU models have spare temperature channels.

3. IAT Through Fuel Temperature Pin – Pin 77 is 
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connected to An Temp 3.  On some models this is used to 
measure fuel tenk temperature.  You can wire an IAT 
sensor between this pin and pin 92 (sensor ground). 
Refer to Appendix B for pin numbering.  Additional 
terminals to fit the factory header are supplied with the 
ECU.

EXPANSION CONNECTOR

The expansion connector is provided to allow easy connection of 
additional ECU inputs.  No additional outputs are provided on the 
expansion connector.  

The following expansion connector outputs are provided:

● Gnd – Sensor Ground Only 
● +5V Out – Supply for MAP sensor
● DI7 – N/C
● DI8 – N/C
● An Volt 6 – Analog 0-5V input for 

external MAP sensor or other analog 
signal such as wideband O2 or a boost 
control knob.

● An Volt 7 – N/C
● An Temp 4 – N/C

Important points when wiring to the expansion connector:

● Use only the supplied expansion loom.

● Do not overload the +5V Out pin.  Although this is 
protected against ECU damage the +5V out signal also 
provides power for other sensors.

● Do not connect the ground pin to chassis ground. This 
could cause ground loops and introduce unnecessary 
interference.  Use this pin only to ground external sensors 
that are isolated from chassis ground.
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ADDITIONAL DIGITAL INPUTS

Not all models are factory fitted with an ECU managed 
intercooler spray system.  If additioanl Digital Inputs are required 
for functions such as motorsport features or table switching, 
these can be wired to the intercooler switch pins on the main 
header.  DI 3 (Manual Spray) and DI 5 (Auto Spray) can be used 
as asitional Digital Inputs.  Refer to the pinout in Appendix B for 
pin locations.  Additional terminals are supplied with the ECU to 
allow wiring to the main header.
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PC TUNING

Although Link ECU's come with base settings that allow the 
engine to be started, ALL aftermarket ECU's must be 
professionally tuned immediately after installation.  Failing to 
have the ECU correctly tuned for your vehicle could result in 
engine damage or violation of emissions laws.

Link ECU's are tuned using a windows based PC/laptop running 
PCLink.

Due to frequent upgrades PCLink is not distributed with new 
ECU's.  PCLink Can be downloaded free of charge from:

www.  LinkECU.com  

Should download of PCLink be impractical an installation CD can 
be purchased at minimal charge from your nearest Link dealer.

INSTALLING USB DRIVERS

WARNING !!!

The G4 ECU has on board USB.  

BEFORE connecting the ECU to your laptop, 
the USB drivers must be installed.  Failure to 
install  the  drivers  on  your  laptop  first  may 
result in windows assigning incorrect drivers. 
These drivers will not work with the  G4 ECU 
and are difficult to uninstall.

Before connecting the ECU to your laptop or PC, the ECU USB 
drivers must be installed.  These drivers are installed as part of 
PCLink installation as described in the following section.
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INSTALLING PCLINK

INSTALLING FROM THE WEB
Go to the Link website and navigate to the downloads and 
software updates section.

1. Download the latest version of PCLink.  When prompted to 
run or save the file, select save.  It is recommended to 
save this file on the desktop.

2. Double click the saved file and follow on screen 
instructions.

3. When prompted to install USB drivers, select yes.  This 
may take some time.

4. When installed, open PCLink by double clicking on the 
icon that has been placed on the desktop.

INSTALLING FROM A CD
Insert the PCLink CD into you computer’s CD ROM.

1. Open 'My Computer'

2. Double click your CD drive.

3. Double click the file labelled PCLinkSetup.exe (or similar 
name).

4. Follow the on screen instructions.

5. When prompted to install USB drivers, select yes.  This 
may take some time.

6. When installed, open PCLink by double clicking on the 
icon that has been placed on the desktop.
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COMMUNICATING WITH THE ECU

PCLink must be installed on a Windows based laptop/notebook 
before any adjustments or tuning can be performed.  The latest 
version of PCLink will be required to tune your ECU and is freely 
available for download from:

www.  LinkECU.com  

Link G4 ECU's have on board USB support.  PCLink Installation 
will also install the required USB driver software.  You MUST do 
a complete install of PCLink before connecting the ECU to 
the PC for the first time.

After PCLink installation, you will be able to connect to the Link 
ECU to the laptop to perform setup and tuning work.

1. Connect the ECU to your laptop using a Link G4 ECU 
USB Cable.  If not supplied with the ECU, these can be 
purchased from a Link dealer.  No other adapter or cabling 
is required.  Connect the cable to the connector labelled 
USB (sometimes marked with an orange O'ring)

2. If this is the first time you have connect a G4 USB ECU to 
you laptop follow the driver installation instructions that 
appear.  When prompted if you want to install drivers 
select 'Continue Anyway'.

3. Start PCLink by double clicking on the PCLink icon on the 
windows desktop.

4. Switch the key to the ON position.  This will provide power 
to the ECU.

5. In PCLink, under the 'Options' menu, select 'Connection'. 
The connection options dialogue will open.  Select the 
correct COM Port number from the drop down list or select 
Auto for automatic com port detection.
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6. PCLink offers both mouse and keyboard control. To 
establish a connection between the PC and ECU using the 
mouse, click the ‘L’ icon located near the top centre of the 
PCLink screen.   Alternatively, press F3.  The same 
process can be used to disconnect.  If a successful 
connection is established, PCLink will download settings 
from the ECU, otherwise you will be warned that an error 
has occurred.

7. Make sure the connection shows “ONLINE” in the top right 
corner of PCLink.   The logo should also be spinning in the 
top right corner.  

8. To permanently STORE any changes made to the ECU 
click on the 'S' icon near the top centre of the screen or 
press F4.  If this is not done before turning the ECU's 
power off all changes made will be lost.

If connection can not be established, contact one of the support 
options given at the beginning of this manual.

Help on individual tuning functions is available through the 
PCLink on line help (Press F1, or right click on any item and 
select 'What's This?').  
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INITIAL ADJUSTMENTS

It is important that the procedures described in the following 
sections are performed before any attempt to start the engine is 
made. 

BASE CONFIGURATION

All G4 Plug-In ECU's are shipped with base configuration 
settings.   Note that these are provided to reduce initial setup and 
tuning times.  They are NOT recommended tuning values. 
PCLink includes base configurations for various models. 
Download the appropriate base configuration into your ECU with 
PCLink by connecting to the ECU (described in the Connecting 
To PCLink section of this manual), then selecting 'Open' under 
the 'File' menu.  Select the appropriate .pcl file and then select 
'Open'.  Downloading large configuration files can take up to a 
few minutes.  Be patient and acknowledge any messages PCLink 
shows.

MAP SENSOR CALIBRATION

The following procedure must be performed before tuning to 
ensure that the MAP Sensor is correctly calibrated.  This is done 
by calibrating the MAP sensor to the ECU's internal Barometric 
Absolute Pressure (BAP) sensor.  The BAP sensor is calibrated 
before the ECU is shipped.  To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to 
the ECU using PCLink.

2. Under the Analog Channels menu, select the An Volt 
channel that has been wired to the MAP sensor.  Select 
the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.
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4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section 
of PCLink (lower part of the screen).

6. Compare the MAP and BAP values and ensure they have 
a similar reading (within 1 kPa).

7. Perform a 'Store' by clicking on the S button (top center of 
screen) or press F4.

TPS CALIBRATION

The Throttle Position Sensor (TPS) is used by the ECU to 
calculate various engine management parameters used by 
functions such as idle speed control,acceleration enrichment and 
motorsport features.  It is important that the ECU knows when the 
throttle is open and closed (or part way in between).  The 
following procedure calibrates the ECU to match the TPS:

1. Connect a laptop/notebook PC to the ECU and connect to 
the ECU using PCLink.

2. Under the Analog Channels menu, ensure that An Volt 3 is 
set to 'TPS (Main)'.

3. Under the 'Options' menu, select 'TPS calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section 
of PCLink (lower part of the screen).

6. Ensure the Throttle Position value reads 0% when the 
throttle is closed and 100% when fully open.

8. Perform a 'Store' by clicking on the S button (top centre of 
screen) or press F4.
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IAT SENSOR SELECTION

This section only applies when an Intake Air Temperature (IAT) 
sensor has been wired and fitted to the intake system.  It is 
important that the ECU is calibrated to match the sensor installed 
in the engine.  This procedure is as simple as selecting the 
correct sensor type as follows:

1. Connect a laptop/notebook PC to the ECU and connect to 
the ECU using PCLink.

2. Click on 'Analogue Channel' in the configuration tree 

3. Select the An Temp channel the sensor has been wired to.

4. Ensure that channel (and only that channel) is set to 'Inlet 
Air Temperature'.

5. Select the correct 'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section 
of PCLink (lower part of the screen).

7. Ensure that IAT reads the correct temperature.

8. Perform a 'Store' by clicking on the S button (top centre of 
screen) or press F4.

INPUT AND OUTPUT SETUP

As the Link G4 EVO IV-VIII Plug-In ECU is designed to run 
several models there are a few items that must be setup to make 
the ECU specific to your model.  This is due to the same ECU 
header pin being used for different functions between models.

Appendix A in the back of this manual gives a list of the functions 
of each channel based on vehicle model.

It is the tuners responsibility to make sure that the following 
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channels are setup up correctly for the vehicle model the ECU is 
fitted to:

● All Auxiliary Output Channels – Use the 'Test On' and 
'Test PWM' (at 10 Hz) functions to test the wiring of 
channels.

● Auxiliary Output – Fuel Channels 5 and 6 - Use the 'Test 
On' and 'Test PWM' (at 10 Hz) functions to test the wiring 
of channels.

● All Digital Inputs – Look at the Digital Inputs runtime 
values (lower section of the PCLink screen) to confirm 
each channels operation.

● All Analog Volt Inputs – Look at the Analog Inputs runtime 
values (lower section of the PCLink screen) to confirm 
each channels operation.

● All Temperature Inputs – Look at the Analog Inputs 
runtime values (lower section of the PCLink screen) to 
confirm each channels operation.  
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PRE-STARTUP

After performing all steps discussed in previous sections of this 
manual, you should be ready to start the engine.  This section 
discusses steps required to run the engine.  It is the tuners 
responsibility to ensure the engine mechanically ready to run and 
that no safety hazards exist.

Should the engine not start, do not crank the motor over 
endlessly.  Stop and diagnose the problem or seek professional 
help.

   For further help on any of the settings discussed in the 
following sections, consult the online Help in PCLink.  Online help 
can be invoked by pressing F1, or right clicking any item and 
selecting ‘What’s this?’.

PRE-START SETUP 

   To avoid potential engine damage and wasted time, the 
adjustments presented in the following sections must be made 
before attempting to start the engine.  

1. Ensure the ECU and all associated components are 
connected and correctly wired/installed.  

2. Fully charge the vehicle’s battery, as the engine will be 
required to be cranked during the setup procedure.

3. Check all oil and water levels are correct.

TRIGGER CALIBRATION

   Trigger Calibration is the process of calibrating the ECU to 
actual engine position.  This procedure is required for all 
applications to ensure actual ignition timing is exactly as 
expected.
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1. Connect the ECU to PCLink.

2. Select 'Fuel', then 'Fuel Setup':

a. Set ‘Injection Mode’ to OFF.  This will prevent 
the engine from trying to start while the triggers 
are calibrated.

b. Perform a Store (press F4) to make sure fuelling 
is not re-enabled if power to the ECU is lost.

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.

4. Perform the correct trigger calibration procedure as 
described in the PCLink online help (Press F1).

5. Set the 'Injection Mode' back to 'Sequential' and 
perform a Store by pressing F4.

   Note that trigger calibration must be performed again once the 
engine is running.  Due to the acceleration and deceleration of 
the crankshaft at low speeds, an inaccurate measurement of 
engine timing is usually made.  Also it is often harder to see 
timing marks with a timing light at slow engine speeds.  Trigger 
calibration should be checked again at between 2000-4000 RPM 
where engine speed is stable and a more consistent timing 
reading can be obtained.
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FIRST TIME STARTUP

After performing steps described in previous sections of this 
manual you should now have the ECU in a state where the 
engine is ready to run.

This section describes important tuning adjustments that should 
be made once the engine is running.

ESSENTIAL TUNING ADJUSTMENTS

MASTER

Master is the ECU's overall fuel trim number or “coarse 
adjustment”  it is important that this number is correct to prevent 
the numbers in the main fuel table running out of range.  This 
setting also provides a fast way to enrich or lean the engine over 
the entire range.

Master is found in the Fuel->Fuel Setup menu and should be set 
so that the numbers in the middle of the fuel table end up around 
a value of 50.  This is to allow sufficient span of the numbers in 
the main fuel table.  A typical value for Master is between 10 to 
15 ms.

INJECTOR VOLTAGE (DEAD TIME) CORRECTION

There is always a delay between the injector being energised and 
the injector actually opening.  Likewise, there is a small delay 
between the injector being de-energised and the injector closing. 
The opening time is considerably longer than the closing time, 
however the overall result is that less fuel will flow for a given 
pulse width than would be expected with an 'ideal injector'.  To 
compensate for this the injector pulse widths are increased to 
compensate for this 'dead-time'.  The dead-time for a given 
injector is a function of the battery voltage, differential fuel 
pressure and the type of injector driver (saturated or peak and 
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hold).  A typical dead-time at 3 Bar differential fuel pressure and 
14 volts is just under 1ms (ms = millisecond = 1 thousandth of a 
second). 

   The injector dead-time table allows the dead- time for different 
battery voltages to be entered.  The values represent the dead-
time in milliseconds.  These should increase with falling system 
voltage.

A professional tuner will know how to correctly set injector dead 
time.  It is essential that this value is correct to ensure stable fuel 
mixture over the entire battery voltage range.

NOTE: any change to the fuel pressure or injectors will require a 
recalibration of the injector dead-times.
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APPENDIX A – PIN FUNCTIONS

EVO IV, V, VI EVO VII, EVO VIII

Auxiliary Outputs

Aux 1 Engine Fan (Low Speed) Engine Fan (PWM)

Aux 2 I/C Spray Relay I/C Spray Relay

Aux 3 Tacho Tacho

Aux 4 Wastegate Solenoid Wastegate Solenoid

Aux 5 ISC Stepper ISC Stepper

Aux 6 ISC Stepper ISC Stepper

Aux 7 ISC Stepper ISC Stepper

Aux 8 ISC Stepper ISC Stepper

Aux – Ignition Outputs

Aux – Ign 3 A/C Clutch A/C Clutch

Aux – Ign 4 Engine Fan (High Speed) -

Aux – Injection Outputs

Aux - Inj 5 FP Relay FP Relay

Aux - Inj 6 FP Speed Relay FP Speed Relay

Aux - Inj 7 CE Light CE Light

Aux - Inj 8 Main Relay Main Relay

Analog Channels

An Volt 1 - MAP Signal

An Volt 2 AFM Signal AFM Signal

An Volt 3 TPS Signal TPS Signal

An Volt 4 Oxy Signal Oxy Signal

An Volt 5 P/S Switch P/S Switch

An Volt 6 Expansion Connector Expansion Connector

An Temp 1 ECT ECT

An Temp 2 IAT (AFM) IAT (AFM)

An Temp 3 - Fuel Temperature Sensor

Digital Inputs

DI 1 Ignition Switch Ignition Switch

DI 2 Start Signal Start Signal

DI 3 - I/C Spray Sw (Manual)

DI 4 Vehicle Speed Vehicle Speed

DI 5 - I/C Spray Sw (Auto)

DI 6 A/C Request A/C Request
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APPENDIX B – PINOUT

Pin ECU Function Pin ECU Function

1 Injection 1 55 Aux 2 (Jumper EVO 4-7)

2 Injection 3 57 Aux 2 (Jumper EVO 8)

4 Aux 5 58 Aux 3

5 Aux 7 71 DI 2

8 Inj 5 72 An Temp 2

10 Ignition 1 73 An Volt 1

11 Aux 4 76 An Volt 4

14 Injection 2 77 An Temp 3

15 Injection 4 82 DI 1

17 Aux 6 83 An Temp 1

18 Aux 8 84 An Volt 3

20 Aux - Ign 4 86 DI 4

21 Aux 1 90 An Volt 2

22 Ignition 3 91 DI 3

23 Ignition 2 92 Sensor Ground

32 Aux – Ign 4 Other Connections

34 Aux – Ign 4 Expansion 1 Signal Ground

35 Aux – Ign 5 Expansion 2 +5V Out

36 Aux – Inj 7 Expansion 3 DI 5

37 An Volt 5 Expansion 4 N/C

38 Aux – Inj 8 Expansion 5 An Volt 5

39 Aux – Inj 6 Expansion 6 An Volt 6

44 DI 5 Expansion 7 An Temp 2

45 DI 6 Expansion 8 An Temp 3
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22 23

11

24

12 13

25 26

31 32 33 34 35 36 37 38

39 40 41 42 43 44 45 46

51 52 53 54 55 56

57 58 59 60 61 62

71 72 73 74 75 76 77 78

82 83 84 85 86 87 88 89

79 80

90 91

81

92



APPENDIX C – KNOWN ISSUES

Current known issues with the Link G4 EVO IV-VIII Plug-In ECU:

● There are currently no known issues.
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APPENDIX D – WARRANTY
Link ElectroSystems Ltd. Warranty Statement

Effective 5pm, April 5th, 1992

All products manufactured or distributed by Link ElectroSystems Ltd. Are 
subject to the following, and only the following, LIMITED EXPRESS 
WARRANTIES, and no others

For a period of one (1) year from and after the date of purchase of a new Link 
ElectroSystems Ltd. Product, Link ElectroSystems Ltd. Warranties and 
guarantees only to the original purchaser / user that such a product shall be 
free from defects of materials and workmanship in the manufacturing process. 
A product claimed to be defective must be returned to the place of purchase. 
Link ElectroSystems Ltd., at its sole option, shall replace the defective product 
with a comparable new product or repair the defective product.  This 
expressive warranty shall be inapplicable to any product not properly installed 
and properly used by the purchaser – user or to any product damaged or 
impaired by external forces.  This is to the extent of warranties available on 
this product.  Link ElectroSystems Ltd. Shall have no liability whatsoever for 
consequential damages following from the use of any defective product or by 
reason of the failure of any product.  Link ElectroSystems Ltd. Specifically 
disclaims and disavows all other warranties, express or implied including, 
without limitation, all warranties of fitness for a particular purpose (except for 
those which apply to product or part thereof that is used or bought for use 
primarily for personal, family or household purposes), warranties of 
description, warranties of merchantability, trade usage or warranties of trade 
usage.

Link ElectroSystems Ltd. License Agreement

The programme in this system is licensed not sold.  Link ElectroSystems Ltd. 
Grants you a license for the programme only in the country where you 
acquired the programme.  You obtain no rights other than those granted under 
this license.  Under this license you may use the programme on only one 
machine at a time.  If you transfer the programme you must transfer a copy of 
this license and all other documentation.  Your license is then terminated.  You 
may terminate your license at any time.  Link ElectroSystems Ltd. May 
terminate your license if you fail to comply with the terms and conditions of this 
license.  In either event you must destroy your copy of the programme.
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